CCS Installation for ECE319K/ECE319H, University of Texas
by Jason J. Kacines, Jonathan Valvano and Ramesh Yerraballi

Step 1: Download and install version 20.2.0 of CCS on your personal computer
(MSPMO0G3507) (If there is a newer version than 20.2.0, ask Valvano or Yerraballi, do NOT
install the newer version). Rather, install 20.2.0; this way everyone is using the same version all

semester) https://www.ti.com/tool/CCSTUDIO
Click Downloads on the right:

Home / Design & development

l
CCSTU D I O Downloads

Code Composer Studio™ integrated development environment
(IDE)

This will take you to the following screen where you should click on “View all versions” so you
can choose the recommended version which is 20.2.0. This is important, otherwise you will end
up with a newer version.

CCSTUDIO — Code Composer Studio™ integrated
development environment (IDE)

Latest version Version: 20.0.1 Release date: 20 Dec 2024

[Z Release notes A Notifications [Z View all versions

CCSTUDIO
Code Composer Studio™ integrated development environment (IDE)
Select a version Latest version Version: 20.0.0 Release date: 02 Dec 2024
Q
N [/ Release notes [ view software details
v20x
viZx Downloads  Supported products & hardware

12.8.1 (30 Sep 2024)
12.8.0 (09 Aug 2024)
12.7.1 (10 May 2024)
12.7.0 (05 Apr 2024)

4 Windows single file (offline) installer for Code Composer Studio

IDE (all features, devices) — 891001 K MDS checksum d8d45e3394351a177b78ef9ca18aff95 [

12.6.0(12 Jan 2024) 4 Linux single file (offline) installer for Code Composer Studio IDE

12.5.0 (04 Oct 2023) (all features, devices) — 982546 K MDS checksum 91758fd591b439c0530860c4ad54c48b  [|§

12.4.0 (10 Jul 2023)
12.3.0 (07 Apr 2023) L macos single file (offline) installer for Code Composer Studio

IDE (all features, devices) — 857468 K MDS checksum fd48e550ae5275bc0be96b0801c58c74 (R

12.2.0 (06 Jan 2023)

Choose single file (offline) installer for your operating system


https://www.ti.com/tool/CCSTUDIO

Extract the downloaded CCS20.2.0.xxx zip file into a folder and launch the
ccs_setup_20.2.0.00012.exe file you find in the folder:

(J Name Date modifiec? Type Size
v Today
Dﬁ ccs_setup_20.0.0.00012 1/6/2025 8:03 PM Application 22,068 KB
u timestamp 1/6/2025 8:03 PM TXT File 1KB
components 1/6/2025 8:03 PM File folder

This will open a installation Wizard click Next >

@ Setup _ %

License Agreement nﬂ

Please read the following License Agreemnent. You must accept the terms of this agreement before continuing with the installation.

]
TECHNOLOGY SOFIWARE PUBLICLY AVAILRELE
Copyright {(e) 20l¢€ Texas Instruments Incorporated
211 rights reserved not granted herein.
Limited License Agreement.
This Limited License Agreement ("Agreement"™) is a legal agreement between you (either an indiwidual or
entity) and Texas Instruments Incorporated ("TI™). The "Software"™ consists of the following materials: (a)
the materials identified as TI proprietary software programs in the software manifest for the software
subject to the terms herein, and any "on-line"™ or electronic documentation associated with these programs, or
any portion thereof (the "Licensed Materials"), and (b) the materials identified as open source materials or
third party proprietary software in the software manifest for the Software, or any portion thereof ("Public
Software"). For clarification, your use of the Licensed Materials is subject to the licensing terms
contained in this AZgreement and your use of the Public Software is subkject to the separate licensing terms
specified in the applicabkle software manifest and/or identified or included with the materials to which they
apply. This Agreement does not limit wour rights under, or grant vou rights that supersede, the license e

® i1 accept the agreement

Do you accept this license?
() 1 do not accept the agreement

= Back Mext > Cancel

Accept the agreement and click Next >



G0 Setup _ w

Please read the information carefully to determine if you need to take any action prior to continuing. nﬂ

Operating System Check -» OK
Installer Path Check -= OK
Unicode Character Check -» OK

Anti-virus Check -> We have detected you are running anti-virus software on this computer. Anti-virus real-time file scanning may interfere with
installation and it is recommended you temporarily disable this feature. Anti-virus software may also block the downloading of files that occurs
during installation. If you cannot disable the anti-virus software, we recormmend the offline installer, which has less interference.

= Back

Cancel

Click Next >/t will ask to reboot, but do it later. (use Version 20.2.0 for Fall 2025)



89 Setup _ w

Installation Directory nﬂ

Please specify the directo VOO0 will e e

Installation Diregfory | SEIGNFNKE | e

v

= Back Mext > Cancel

Note: It is recommended to leave the Installation Directory as the default. If you would like
to change the installation directory, make note of the location that you are installing Code
Composer Studio and ensure the directory includes \ti\ccs2020 in the path.



89 Setup _ w

s 3
Select Components nﬂ

Select the components umWo not want to install. Click Mext when you are ready to continue,
<

MSPMO Arm® Cortex @ -M0O+ microcentrollers __-J Click on a component to get a detailed description
lﬂﬂm— "

[] c2000™ real-time microcontrollers

[ Wireless Connectivity

[ Arm®-based processors

[] AM2x Arm ®-based high perfermance microcontrollers
[] mmWave Sensors

[] Hercules™ Safety MCls

[ ™M4C12% Arm® Cortex @ -M4AF MCUs

[] C6000 Power-Optimized DSP

[] OMAP-L1x DSP + Arm3™ Processor

= Back Mext > Cancel

Select MSPMO Arm Cortex-M0+ Microcontrollers and click Next >



89 Setup

Ready to Install

50

Setup is now ready to begin installing CCS 20.0.0.00012 on your computer.

= Back

,
[~

Cancel

Click Next > to begin installation (this will take a long time)




G0 Setup _ w

Completing the CCS 20.0.0.00012 Setup Wizard

Setup has finished installing CCS on your computer,

Create Desktop Shortcut
Launch CCS

50

code composer™
STUDI O

Cancel

<Back [ Finish |

CCS is now installed.

Launch Code Composer Studio. The following screen will appear. If the LaunchPad is plugged
in, then CCS will recognize it.



File Edit Selection View Go Project Run Scripts Terminal Help Code Composer Studic

Get Started X

Code Composer Studio™

User guide

LP-MSPMO0G3507 LaunchPad (my board) Overview

LP-MSPMOG3507 Getting started

Serial: MG350001

Projects and build

Debug

with Code Composer Studio™ IDE Th emes

Dark (Theia)

with MSPMO Academy

X ®@0A0 A Collaborate

Close Code Composer Studio and install the SDK (next steps)

Step 2: Download and install version 2.05.00.05 of MSPM0-SDK — MSPMO0 Software
Development Kit (SDK) https://www.ti.com/tool/MSPMO0-SDK

Do not install the newest, rather install Version: 2.05.00.05 (this way all of ECE319K is running
the exact same installation) mspm0_sdk_2_05_00_05

On the SDK page, click on Downloads and you will find the following dropdown options where
you can click on “View all versions and releases detail’

Download v

pment
Direct downloads  GitHub repo  Custom downloads
Latest version Version: 2.03.00.07 Release date: 27 Nov
2024
4 MSPMO SDK for Windows
MDS5 Checksum d3daleeb446534 .. [§
Jnostic

4 MSPMO SDK for Linux

MDS5 Checksum fa646flebSbadae ... [§

nvare sC -y MSPMO SDK for macOS

MDS5 Checksum  3fa0a67ffacb1180... [§

- View all versions and release detail /

This will take you to the page where you choose the version 2.05.00.05.


https://www.ti.com/tool/MSPM0-SDK

MSPMO-SDK

MSPMO Software Development Kit (SDK)

Select a version

2.03.00.07 (27 Nov 2024)
2.02.00.05 30 A0y 2024)
2.01.00.03 (10 Jun 2024)

2.00.01.00 (30 Apr 2024)
2.00.00.03 (10 Apr 2024)
vix

1.30.00.03 (26 Jan 2024)
1.20.01.06 (20 Nov 2023)
1.20.00.05 (06 Oct 2023)

1.10.01.05 (23 Aug 2023)
1.10.00.05 (05 Jul 2023)

1.00.01.03 (16 May 2023)
1.00.00.04 (03 Mar 2023)

Download the SDK for your operating system. If you are asked to create an account do so.

Latest version Version: 2.03.00.07 Release date: 27 Nov 2024

[ Release notes A Notifications [ View software details

Downloads  Supported products & hardware

B mspm0_sdk_2_03_00_07.exe — 150560 K

B mspm0_sdk_2_03_00_07.run — 150734 K

B mspm0_sdk_2_03_00_07.app.zip —153171K

B = Requires export approval (1 minute)

Run the mspm0_sdk executable to download the SDK

MSPMO SDK for Windows

MDS5 checksum  d3daleeb446534a3852a6910b5c4b0o7

MSPMO SDK for Linux

MDS checksum  fa646f1eb5Sbadae2380b843e674011100

MSPMO SDK for mac0S

MDS checksum  3fa0a67ffacb11800576b30ace795925

@ Setup

Setup - mspm0 sdk 2.03.00.07

Welcome to the mspm0 sdk 2.03.00.07 Setup Wizard.

Cancel

]

U]

]



* Setup — O >

License Agreement ¢

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

L]
Terxas Instruments Incorporated
Software License Rgreement
IMPORTANT - PLEASE CAREFULLY READ THIS AGREEMENT, WHICH IS
DISPLAYED FOR ¥YOU TO BRERD PRIOCE TO USING THE LICEWMSED MRTERIRLS
(DEFINED BELOW) . ¥OU WILL BE ASEED HER ¥OU RCCEPT AND REREE TO
ITS TEEMS. BY CLICEING "I RCCEFTZ "I REREE,™ OR BY USING: THE
LICEMSED MRTERIATS. YOU | SENT THAT YOU HEVE THE LEGAL ¥

ept the agreement

Do you accept this license? :
() | do not accept the agreement

< Back Mext = Cancel

* Setup — O

X
Installation Directory ‘5‘

Please specify the directory where mspm( sdk 2.03.00.07 will be installed.
The following directories will be created in this directory:

mspm0_sdk_2_03_00_07

Installation Directiiny C:"-.,ti

| B2

< Back Mext = Cancel




Note: This installation directory MUST be the same as the one used for Code Composer Studio.
If you did not previously change the installation directory from the default, do NOT change it
here. If you DID previously change the installation directory, update it accordingly here. If you
encounter errors when building the project later, please check the FAQ.

+ ]

Ready to Install ”

Setup is now ready to begin installing mspm0 sdk 2.03.00.07 on your computer.

< Back Mext = Cancel

Click Next > to begin installation (this will take some time)



* Setup — O >

Completing the mspm0 sdk 2.03.00.07 Setup Wizard

Setup has finished installing mspm0 sdk 2.03.00.07 on your
computer.

View M5SPMO SDE Release Motes

Cancel

Click Finish >

REBOOT YOUR COMPUTER



Step 3: Download and unzip the projects for ECE319K called MSPMO0_ValvanoWare. You
will find the zip file here: MSPMO0 ValvanoWare Fall25.zip (updated 8/27/2025)

Put the folder MSPMO_ValvanoWare somewhere it is easy for you to find and edit. Notice there
is one master directory, 42 subdirectories containing individual lab projects. Make sure this is
the exact structure of your project workspace.

I 4 <+ | MSPMO_ValvanoWare M' ‘t . — O x
Home Share View ‘]S el

_J . Cut x

'-‘?'J' Ii-| Open BaSelectaH

-/ Copy path Lk Edit Select none
Pinto Quick Copy Paste Move Copy Delete ame New Properties
access #| Paste shorteut to to - folder - 4 History E,D Invert selection
Clipboard Mew Open Select
- v » This PC v @ Search MSPMO_Valvano.. @
|= Documents e Name Type Size ()
4 Downloads ADCSWTrigger File folder
b Music AssemblyExamples File folder
&= Pictures CrystalfontzLCD File folder
Videos DAC File folder
=, 0S(C) Datasheets 142 831 AM File folder
. Documentation e d & l l‘ b 1 4
swnEAgent > Individual lab projects
A
Ppe ECE319K_Lab 1272024 851 AN Hile tolder
cygwin64 ECE319K_Lab2 File folder
Dell ECE319K_Lab2H File folder
Drivers ECE319K_Lab3 File folder
EAGLE 9.6.2 ECE319K_Lab4 File folder
Intel ECE319K_Lab3, File folder v
v <€ >

v

49 items =

Step 4: Plug the MSPM0G3507 LaunchPad into a USB port. Open CCS, Click Explorer, then
click WORKSPACE_CCSTHEIA

File FEdit Selection View Go

@ %;LC:REF: == EH 1

> OPEN EDITORS Z
> WORKSPACE CCSTHEIA

Execute File->Add Folder to Workspace


https://utexas.box.com/s/xdqpi1vcqxhnte44i4262pcxbo75a5jz

Selection

ik

£ Import Projec

Mew Text File
Mew File...

Mew Folder...

Cpen Fle...
Cpen Folder...

Open Wo

Open Recent Workspace...

View

E3 Create New Projétre

ace from File...

Go Project Run

Ctri+M

Ctril+AKk+N

Ctrl+O
Ctrl+K, Ctr+0O
Ctri+alt+W

Ctl+Alt+R

Add Folder to Workspace... (

Save Workspace As

Save

ave All

Ctri+S

Cirl+Alt+5

Browse for the MSPMO0_ValvanoWare folder
1) Single click on MSPMO0_ValvanoWare folder

2) Execute Select Folder

Scr

ipts  Terminal

A0G3507 Launchi

10G3507 Launch

3350001

§p Select Workspace Directory *
<« v 4 s v ThisPC » 0S(C) » v O Search 05 (C:) yel
Organize Mew folder == - e
~
web A Name Date modified Type Size G
Lyygwinus rue e
@ OneDrive - Personal Dell File folder
[ This PC Drivers File folder
X EAGLE 9.6.2 File folder
J 3D Objects )
Intel File folder
I Desktop Keil 5 File folder
=/ Documents Keil_vs l File folder
‘ Downleads KofaxPowerPDFStandard-3.0.0 4/ File folder
J’) Music MSPMO _ValvanoWare 1 File folder
&=/ Pictures OneDriveTemp Eile falder
B Videos PerfLogs Size: 238 MB
£ osicy Program Files Folders: jubrowser.userdata, metadata, ADCSWTrigger, ...
- : Program Files (x36) Files: Doxyfile, license.tut, ...
l seagate Bxpansion Drive ProgramData File folder
= MNew Valume (F) v Recovery File folder 2 v
v ]
Folder: | MSPMO_ValvanoWare
Select Folder Cancel




Folder added to Workspace x

A workspace with multiple roots was created. Do you want to save your workspace configuration as a V

No Yes

Notice the path to the MSPMO0_ValvanoWare folder matches where you put it. Click
Launch. Save workspace configuration as a file

G Save Workspace As...

1T » Jonathan Valvano » workspace_ccstheia

v O Search workspace_ccstheia »p
Organize Mew folder

=R ’ ]
~
) Name Date modified Type Size
3 Quick access
[ Desktop
‘ Downloads

| Decuments

Mo iterns match your search.

&= Pictures

& GoogleDrive

& Google Drive

&8 EEM5LTeachingt
Fall2024

2 MSPMO_Labs
RightHeart

v

File name: ‘ ECE319K L

2 v
Save as type: | Theia workspace (*.theia-workspace)

-
~ Hide Folders Cancel

Notice all the projects, You should now see all of the projects on the left hand side of CCS




File Edit Selection WView Go Project Run Scripts Terminal Help Code Composer Studio
@ EXPLORER ---  EB Get Started X

> OPEN EDITORS
~ BEHK.. AEF D & -

Code Composer St

Dratasheets

T E e LP-MSPMDG3507 LaunchPad (my board)

LP-MSPMOG3507 LaunchPad™ development kit
Serial: MG350001




Step 5) Click on Lab1 and execute Project->Build. It should compile.
The console should output **** Build Finished **** without any errors, if you get errors check
the FAQ or ask a TA on the class forum for help

3 [ output x [} GEL Output = ial C gl D ole ccs: project-build

march=thumbvém -mcpu=cortex-m@plus -mfloat-abi:

If it get can’t find SDK, execute these steps (if it builds, go to Step 6)
File->Preferences->CodeComposerStudio Settings

View Go Project Run Scripts Terminal Help Code Composer Studio

Mew Text File Ctri+N
MNew File... Ctri+Al+MN

de Composer Stut

Add Files/Folders...

Open File... Ctri+Q
Open Folder... Ctrl+K, Ctrl+O
Cpen Workspace from File... Ctri+aAlt+W

Cpen Recent Workspace Ctri+Alt+R
ADG3507 LaunchPad (my board)
Add Folder to Workspace...

Save Workspace As...

Ctri+5 10G3507 LaunchPad™ development kit

Ctri+Alt+S 3350001

Auto Save

Preferences Code Composer §
General Settings... Ctri+,

Cirl +Alt+,

[P Exit

Color Theme Ctri+K, Ctr+T

File Icon Theme

Products, SDK should be in C:/ti, click refresh to find the SDK, then OK



Code Composer Studio Settings

~ General
¢ Compilers
[I% Products
s Variables C:/Prografn Files/Texas Instruments
Clang-Tidy
Dropbox
~ Debug
B Runtime (RTOS) Obj...

Discovered products

FIVI0 SDK
II% 2.3.0.07 [Cy/ti/mspm0_sdk_2_03 00 07]

' to customize your Workbench _p

Cancel (0], 4

Double check the connection to SDK. Click Lab1 project, right click and execute Properties



File Edit Selec Mew File...

@ EXPLORER Mew Folder...
Add FilEE_,:"FI:lII;jErEH_

> OPEN EDITORS N
Reveal in File Explorer Ctrl+Alt+P
~ EBECE319K (WORKS
~ EJ Folder: w
ECE319K Select for Compare
~ 1 Folder: M

Cipen in Integrated Terminal

Find in Folder... Alt+Shift+F

Copy Ctrl+C
Paste Crl+V
Copy Path Alt+Shift+C

Copy Relative Path Ctrl+K, Ctrl+Shift+C

#% Build Project(s) cul+s
> FlDebug Clean Project(s)
> B3 targetC Rebuild Project(s)
> B3 ticlang
aClock.c

ECE319
ECE310 Executable Actions

Build Configurations

System Configurations

mLaunchf 1% Debug Project F5
mspm0:
READM
s UART.C Delete

& UARTDL Duplicate

Rename :
= Properties... K Alt+Enter

1 Flash Project Ctrl+F5

Click Dependencies, and notice the SDK version 2.3.0.07 and SysConfig 1.22.0



Properties for: ECE319K_Lab1 [Debug]

~ General Z
1% Dependencies

(& Variables II% MSPMO SDK
~ Build Il sysConfig
= Steps

ey Link Order

~ % Tools

? SysConfig

@ Arm Compiler

@ Arm Linker

% Arm Hex Utility Project dependencies
/2 Arm Objcopy Utility

Executable Actions

Clang-Tidy

Debug

Cancel Save and Close

Step 6) Verify the MSPMO0G3507 LaunchPad is connected to a USB port. Click on the
ECE319K_Lab1 project and execute Run->Debug Project. This will erase flash ROM, program
flash ROM with the object code, and launch the debugger. The first time it debugs it will ask to
update the firmware. Click ok and do update firmware.



File Edit Selection View Go Prc:_j}Run Scripts Terminal Help

S — *..¥ & Debug Project (ECE319K La..) e"" F5

m] Flash Project (ECE319K_La... Ctrl+F5
> OPEN EDITORS &) Fla Ject ( -La-)

&> Start Debugging

~ ECE319K (WORKSPACE)
~ ] Folder: MSPMO_ValvanoWare . ®
> B3, ADCSWTrigger
> B3 AssemblyExamples
> B3 CrystalfontzLCD

> E3,DAC

> B3 Datasheets
> B3 Documentation / ®© dock

v B,ECE319K LabT
> B, Debug Load
> B3 targetConfigs Edit Source Paths...
> B3 ticlang Open Configurations
Ce & Add Configuration...
ECE319K_Lab1.s
C ECE319K Lablmain.c
Cg LaunchPad.c
mspm0g3507.cmd
README.html
C"E:- UART.c
C._ UARTbusywait.c
In the debugger you will see it is ready to run the main program, which is the debugger

Dummy ;

main ( M
Clock Init88MHz(
LaunchPad Init(}; i .
UART Tnit(); ’ IH thf‘ gl‘ﬂder
if(stremp(EID," 777123 )

UART OutString("Please your EID in ECE319K Labl.s™);

EndLabl( };

SizeofEID = 8;

Step 7) (Windows only, Macbook skip this step) Plug in the LaunchPad. Open the Device
Manager and make note of the COM port number for the XDS11 Class Application/User
UART (COMS30 on this computer, your computer will be a different COM port number). Notice
also the Texas Instruments Debug Probes.



;.l.; Device Manager

File Action View Help

o= m HE B

H Portable Devices
v [ Ports (COM &LPT)
i Communications Port (COM1)
E LISE Senal Device (CORME)
i XDS5110 Class Application/User UART (COM30)
ﬁ ADS110 Class Auxiliary Data Port (COMZ29)
= Print queues
[ Processors
B Security devices
!t Software components
B Software devices
I Sound, video and game controllers
& Storage controllers
i3 Systemn devices
w [OF Texas Instruments Debug Prob

@ XDS110 Class Data PDdVE

L& XD5110 Class Debug Probe

A R ArC IR

Step 8) In the debugger, open a terminal window by executing the menu command

View->Console->SerialConsole

File Edit Selection View Go Project Run Scripts Terminal Help

Command Palette... Ctrl+Shift+P

DEBUG
Open View...

ECE319K_Lab1 .
Appearance
+ -

> < 5

> THREADS

E Editor Layout

(:} Resource Explorer

> CALL STACK

 VARIABLES Console

s 2 @ Connected Targets
Debug Ctrl+Shift+D

= Disassembly

Explorer Ctrl+Shift+E
[ GEL Files

b Graph

ECE319K_Lab1main.c X

ablmain.c >

> Phase

&) Debug Console Ctrl+Shift+Y
[ Debug Output

Bk GEL Output

& Scripting Console

E Serial Console

Open a Terminal by clicking Serial Console (bottom of the screen) and then clicking the

Connect/Disconnect COM port icon

[=] Serial Console X




Select the COM port for XDS11 Class Application/User UART (Windows version), baud rate
of 115200 bits/sec, no parity, 8 data bits, 1 stop, save as default. Your COM port will probably be
different, but make it match Step 7 above.

COM Port

Port: ﬂCDMED (Texas Instruments Incorporated)

Baud Rate: 115200

A
1

Parity: none

A

Data Size,, 8
Stop Bits;_ 1

¥ Save settings as default

Choose Serial Terminal and select one of the /dev/cu.usbmodem device. My mac used the
MG3500011 device (Macintosh version)




Launch Terminal

Choose terminal: | Serial Terminal /

Settings

Serial port: [dev/cu.Bluetooth-Incoming-Port v

[dev/cu.Bluetooth-Incoming-Port

Baud rate:
[dev/cu.usbmodemMG3500011 e

Data size:  [dev/cu.usbmodemMG3500014
Parity: None

Stop bits: il

Encoding: | Default (ISO-8859-1)

2]

Click the Continue toolbar to start execution

File Edit Selection View Go Project Run Scripts Terminal

DEBUG

ECE319K Labl ..~ $% [bJ Em

Typd

I )

=~ if(mistake
UART Out

UART Out
~ VARIABLES

57 UART_OutSt

E] Serial Congole X

AN




E Serial Console X

Step 9) Disable Auto Check Update
Go to File->Preferences->General Settings...

File Edit Selection View Go
B2 Create New Project...

2 Import Project(s)...

New Text File
New File...

New Folder...

Open File...

Open Folder...

Open Workspace from File...
Open Recent Workspace...

Add Folder to Workspace...
Save Workspace As...

Save

Save All

Auto Save
Preferences
[ Exit
> B3, ECE319K_Lab2

B3 ECE319K_Lab2H
B3 ECE319K_Lab3

>
>

Project Run Scripts Terminal Help

arted CE 3 Settings X
Ctrl+N
Ctrl+Alt+N

Commonly Used
Text Editor
Workbench
Window

Features

Ctrl+O
Ctrl+K, Ctrl+O
Ctrl+Alt+W

Ctrl+Alt+R -~
Application

Security

Extensions

Ctrl+S
Ctrl+Alt+S

Code Composer Studio Settings...
Ctrl+,
Ctrl+Alt+,

General Settings...

Keyboard Shortcuts

Color Theme Ctrl+K, Ctrl+T

File Icon Theme

In Search settings, type in “updates”
Uncheck the box under CCS>Update: Auto Check Update

32 Settings X

updates

User orksy

v Extensions (6)
CCS (2)
clangd (1)
Markdown (3)

CCS > Debug: Serial: Options: Send Characters On Enter

CCS > Update: Auto Check Update
B Auton b

atically check availabl

Clangd: Check Updates

Continue to Part a on the Lab 1 document



FAQ (these need updating for CCS 20.2)
0. I get these two warnings when | build

*! Problems » = Memory Allocation = Stack Usage
0 errors, 2 warnings, 0 others
Description Resource

b

Warnings (2 items)
% Product SysConfig v1.17.0 is not currently installed, A compatible version 1.19.0 will be used,  ECE319E_Lab1

This project was created using a version of compiler that is not currently installed - TICLANG_. ECE319K_Lak1

Problem 0. Valvano built the MSPMO_ValvanoWare projects, then Tl upgraded CCS from 12.4
to 12.5 then to 12.6 within the space of a month, rendering all the project settings obsolete.
Solution 0a. Ignore these two warnings. Don’t ignore all warnings. We do not use SysConfig
and any compiler version is ok
Solution 0b. If the warnings bother you, you could change the preferences for all 30 projects
1) Right-click the project name in the Project explorer, select Properties

2) Select General

3) Pull down Compiler version and select the newest Clang compiler

4) Click Apply and Close

B ERIBi%- 0 R-i0if- S

[y Project Explorer = <'§|) Y & = O [ Getting Started [ UARTZ.c [£] UARTZ.cpp LabBMain.c (€] Lab8HMain.cp
s
I ADCSWTHgger | oy b erties for ECE319K_Lab1 m| ®
i AssemblyExamp
s
11? CrystalfentzLCD ‘t:pefiltertext General & - -
12 DAC g2 |
1 ECEFT9R_Lab1 Zem"l‘e 2
) enera k
= oo | ¥ P Confguation: [Debug [ Acte]  MonogeConfgrtons.
1S ECE319K_Lab3 SysCanfig
1 ECE319K_Labd v Arm Compiler .
1(9 ECE319K_Lab5 ;mfes.snr.Opt\nns 1% Project = Products
- timization
5 ECE319K_Lab P
s Include Options Device
5 ECE319K_Lab7
1;9 ECE319K L ab7H irdedefmeddéyrhhn\s Family: Arm
5 vance tions
I ECE319K Lab8 Ar Link e Variant and core: 8 MSPMOG3307 CORTEX_MOP
T ECE319K_Lab2H frm Hnker
% ECE319K_Labd i’m EZ" Ut"'t)fu [IPISE[hDI'EdL\ " Connection: 8| Texas Instruments XDS110 USB Debug Probe [Default] v Verify..
5 rm [<= tili isable:
l= ECE319K Lab3H Deb icopy Uity Manage the project's target-configuration automatically
i EdgeTriggeredin oM
11,3 12¢ Project type and tool-chain 3
s
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1) Right-click the project name in the Project explorer, select Properties

2) Select General

3) Click the Products tab
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4) Click SysConfig
5) Click Edit...
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6) Select the newest SysConfig installed on your system
7) Click Ok
8) Click Apply and Close
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1. When | build the project | get this error, what’s the problem?

ticlang.d

Problem 1: When installing CCS or the SDK, the default location was changed and not
updated correctly

Solution 1: Re-install the SDK and double check that it is located in the same directory
as CCS. Find where you installed CCS (ex: C:fti/ccs...) and install the SDK in C:/ti/

Problem 2: CCS cannot locate the SDK in its current location

o000



Solution 2: Open Window > Preferences. In the Product discovery path, add the
location of the SDK. This issue will often arise if you decide to install CCS and the SDK
on a different drive from the default. Once the new discovery path has been added you
should see the SDK appear in the Discovered products window. Click Apply and Close
and rebuild the project.
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Grace
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Version Control (Tearm)

M Search for products each time Code Composer Studio starts (may affect start-up time)

Restore Defaults Apply

Apply and Close

Problem 3: CCS cannot debug
Solution 3: Verify the board is plugged in and the Texas Instruments Debug Probes are
visible in the Device Manager

Problem 4: You get red errors when launching the debugger.
Solution 4: How to unbrick the MSPM0G3507:

1) Press-and-hold the BSL_Invoke button (S1, near LED) while pressing and releasing
the Reset button.

2) The device should go to BSL and stay in Active mode for ~10secs.

3) Attempt to program immediately after releasing the reset button.

4) Release the BSL_Invoke button (S1, near LED).



Problem 5: You get this error when launching the debugger.

[ Debug Output X =

Texas Instruments XDS110 USB Debug Probe/CS_DAP_0 Error initializing X
emulator: (Error -260 @ 0x0) An attempt to connect to the XDS110 failed.

The cause may be one or more of: no XDS110 is connected, invalid

firmware update, invalid XDS110 serial number, or faulty USB cable. The
firmware and serial number may be updated using the xdsdfu utility found

in the .../ccs_base/common/uscif/xds110 directory of your installation. View
the XDS1...

Cancel Retry

Solution 5: This error is usually caused by the board not having the correct firmware.
Ensure your firmware is up-to-date when prompted. Some computers are unable to
update the board’s firmware (especially Surfacebooks with Snapdragon CPUs), but you
can plug in the board to another laptop with CCS and update the firmware from there.

Problem 6: launch.json is not a valid JSON file. Missing debug configuration properties.
Solution 6: This issue is caused by having multiple root directories in the workspace.
Sometimes, CCS will have an extra root directory called ccs/theia (anyone have a
screenshot of this?). Right click it and remove it from the workspace. Your workspace
should look like this:

» ECE319K (WORKSPACE)

General Troubleshooting:
CCS is finicky. Sometimes doing some combination of these things will work.
- Check the jumpers
- Unplug/replug the board
- Restart CCS/restart computer
- Build the project then do Run—Flash before Run—Debug
- Close and reopen the serial console
- Change USB cable
- Try the BSL thing in Solution 4
- Factory reset the board



